
NEWSLETTER #97 - December 2020

Our newsletter turns 8!! ‘Twas December 2012, just before SumProduct’s very own 
third birthday, when we unleashed our first newsletter – who would have thought we’d still be doing monthly newsletters of 500 pages 
or more (well, seems like it anyway!) eight years later?

It may be the end of the year, but there is no letting up as we say goodbye to 2020 (not many will be sad to see it go).  This month we 
look at Excel Organization Data Types from Power BI, the fact after 900 years of Excel you may now unhide multiple sheets and even 
divulge that LET has been let loose.

The regulars are all in another jam packed newsletter too: we have another Beat the Boredom Challenge, Visual Basics, Power Pivot 
Principles, Power Query Pointers, Power BI updates, the A to Z of Excel Functions look at two very different FILTER 
functions, and there is even space for Keyboard Shortcuts (how would you function without them?).

Happy reading and remember: stay safe, stay happy, stay healthy.

Until next year.  Season’s greetings to you all / happy holidays.
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Liam Bastick, Managing Director, SumProduct

Excel Organization Data Types from Power BI
You might be starting to get lost with all these new fangled features in 
Excel, but that’s because the change of pace for the pace of change is 
getting very noticeable.  We all work with data, day-in, day-out, and 
Excel already has powerful features to get and transform your data, 
using Get & Transform / Power Query and Power Pivot.  Now, Power 
BI gets in on the act, as enterprise data discovery and analysis becomes 
more readily accessible in Excel.  From late, late October, Organization 
data types from Power BI have become Generally Available, making it 
even easier to get information into your spreadsheets.

It’s all to do with the evolution of Data Types.  

For many years, Excel was seen as “just” a three-dimensional 
spreadsheet, merely data in rows and columns, across multiple sheets.  
Let’s be honest: it was very good at that.  But it had its limitations.  This 
had limitations when you wished to analyse data in more dimensions.  
Now, Data Types adds more dimensions to your data, like the relational 
database countless users try to build in Excel every day.  Any cell may 
now contain a rich set of structured data in just a single cell.
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Data types are rich (hence, they are often referred to as “rich Data 
Types”), going well beyond numbers and text strings: just one cell value 
can contain a deep collection of hierarchical data, references to other 
data types, images, etc.  They are also connected and can point to live 
services providing data that can be refreshed at any time, such as one of 
the first types, Stocks.

With Data Types, a single cell value can have a live connected set of 
information you can quickly pull into your decision-making process, 
without needing to constantly go back to the original source to find more 
information.  You may leverage the card view 

to see more information on that Data Type, and navigate through to related information.  That additional information can be used in the formulae 
you write, charts you create, it can even be used to change how you sort and filter. 

In addition to the flexibility, data types also give you more confidence in the data you are viewing.  For example, if you were to import the data type 
for Seattle, you can now use a formula to reference the population =A1.population.

If the data type updates, the results of the formula will update too.  Just 
seeing the static number 729,601, you also can see the formula and you 
now know exactly where that number came from, and even have the 
ability to ‘Refresh Data’.

While publishing your data into Power BI gives you and your team an 
easy way to discover and import data types into Excel, you can also 

create your own Data Types connecting directly to almost any data 
source you want.  Excel has always supported a large set of data sources 
for direct import into the spreadsheet, and thanks to Power Query, you 
can also build powerful queries and transformations to get the data 
you’re looking for.

This IS the data you’re looking for…
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Now, when you import data into your spreadsheet, you’ll have the option 
to transform that data into a Data Type.  In Power Query, you can create 
your very own custom data types using any source of Organization (sic) 
data available within the Get Data menu, e.g. files, databases, online 
services, other sources – the list is long.  From here, you can pull in, 

clean up and curate, and transform that data into custom Data Types 
according to your needs and preferences.  These Data Types live within 
the workbook you’re building, allowing you to simplify large volumes of 
data and make it easier for colleagues to consume. 

Power Query data types will automatically update from the connected 
data sources too.  

But that’s not all: with Wolfram Alpha data types, there are hundreds of 
additional Data Types coming to Excel, and we have previously discussed 
some of these in past newsletters.  

Now that Data Types may use information from your company or 
organisation, leveraging Power BI as an ideal source of authoritative 
data as the next step makes sense.  This adds centralised and controlled 
access, row-level security, and Microsoft Information Protection (MIP) 
sensitivity labels to the flexible and familiar environment of Excel.

The first step to using Organization Data Types is determining what information from Power BI you want, then simply enable them for Excel.  To do 
this, you need to define tables as ‘featured tables’ in Power BI.  To do this:

 • Turn on the featured table Preview, by selecting File -> Options and Settings -> Options -> Preview Features
 • Select the ‘Featured tables’ check box

	 •	 Restart	Power	BI	Desktop
	 •	 Then,	go	to	Model	view
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	 •	 Select	a	table,	and	set	‘Is	featured	table’	to	Yes

	 •	 In	Set	up	this	featured	table,	provide	the	required	fields:

	 	 o	 a	description
	 	 o	 the	‘Row	label’	field	value	is	used	in	Excel	so	users	can	easily	identify	the	row.		It	appears	as	the	cell	value	for	a	linked	cell,	in	the	‘Data		
	 	 	 Selector’	pane,	and	in	the	Information	card
	 	 o	 the	‘Key	column’	field	value	provides	the	unique	ID	for	the	row.		This	value	enables	Excel	to	link	a	cell	to	a	specific	row	in	the	table

	 •	After	you	publish	or	import	the	dataset	to	the	Power	BI	Service,	the	featured	table	is	displayed	in	the	Excel	Data	Types	Gallery.		You	and	other		
	 	 report	creators	can	also	create	reports	built	on	this	dataset

Excel	caches	the	list	of	Data	Types	so	you	need	to	restart	Excel	to	see	newly	published	featured	tables.		Some	datasets	aren't	supported	in	the	
Preview;	featured	tables	defined	in	those	datasets	won’t	appear	in	Excel.		Limitations	include:

	 •	 Featured	tables	in	Power	BI	datasets	that	use	DirectQuery	datasets	or	Datasets	with	a	live	connection
	 •	 Excel	shows	only	data	in	columns	and	calculated	columns	in	the	featured	table.		Measures	defined	on	related	tables,	and	implicit	measures		
	 	 calculated	from	relationships,	aren't	provided	in	the	initial	Preview
	 •	 Excel	only	displays	featured	tables	that	are	stored	in	the	new	Power	BI	workspaces.		Featured	tables	stored	in	the	classic	workspaces	aren't		
	 	 shown	as	data	types	in	Excel.		You	can	upgrade	classic	workspaces	to	the	new	workspaces	in	Power	BI.

As	an	example,	if	you	wanted	to	work	with	Power	BI	data	on	products,	you’d	enter	a	list	of	product	names,	select	them,	and	then	convert	using	
your	organisation’s	‘Products’	Data	Type.
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You can view the data type card by selecting the suitcase icon in the cell:

If your data is sensitive, you can use Microsoft Information Protection 
sensitivity labels in Power BI. These labels will be applied to your Excel 
workbooks when you convert or refresh your Organization data types.  
This requires MIP labels in Power BI (please ensure that you enable 
sensitivity labels in Power BI) and Office (subscription and licensing 
conditions must also be satisfied for sensitivity labels in Office).

Data Types from Power BI are available to Excel subscribers in 
organisations with Office 365 or Microsoft 365 and the Power BI Pro 
Service plan with English added as an editing language (more languages 
will be coming soon, apparently).  The feature is currently available on 
the Current Channel in Excel for Windows and coming soon to Excel for 
Mac and Excel for the web.

 or you can add fields to the grid:

Unhide Multiple Sheets
We have all been here.  You have an Excel file and you need to unhide some hidden sheets.  There are a few of them, and you know it’s time to get 
Repetitive Strain Injury.  You right-click to unhide sheets…
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…and then you see it’s time to unhide them one at a time:

(Sigh.)

WELL, NOT ANY MORE!!

Now, with Office 365 Insider / Beta / Nigel (whatever it’s called this week…), there has been an update!  Look what happens now:

After 30,000 years of Excel (maybe a slight exaggeration), you can now 
unhide more than one sheet at a time using either CTRL or SHIFT!  Ladies 
and gentlemen, I can confirm we have exited the Dark Ages: industrial 
revolution here we come.

As we say, this is an Office 365 Insider / Beta update, but you should see 
it in other variations of Office 365 soon.  As always, it’s less likely to come 
to the “perpetual” licences any time soon (if at all).  Don’t shoot me; I’m 
just the messenger…

[No, it doesn’t make your row size grow – it’s a screenshot from a different PC!]

LET Off the Leash
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March 2020 saw Microsoft announce a new Excel function, LET, for 
Office 365, albeit at the time of writing, only to the Insiders – now Beta 
– Channel.  This allowed you to stop writing the same expressions time 
and time again in a formula or allowed portability of segments of a 
computation for different formulae.  As Microsoft puts it, it’s “…names 
on a formula level”.

Now (November 2020), it’s been made Generally Available to all users 
of Excel subscribers in the Office 365 or Microsoft 365 in the Production 
Current Channel.  

In essence, this function assigned values or expressions to defined names 
and then passed these to calculation results.  It may store intermediate 
calculations, values or defining names inside a formula.  The defined 

names only apply within the scope of the LET function in a similar way to 
variables in general programming scenarios.

If you reuse the same expression multiple times in a formula, Excel 
calculates that expression multiple times.  That’s not a good thing.  LET 
allows you to name the expression and refer to it using that name, 
similar to VAR in a DAX expression, for those that know the language.  
Any named expression is calculated only once, even though it may be 
referred to many times in the formula.  This can significantly improve 
performance considerably and speed up your spreadsheets.

Let’s recap the LET function.  We must define pairs of names and 
associated values, and a calculation that uses them all, as the final 
argument.  At least one name / value pair must be defined.

It has following syntax to operate:

LET(name1, value1, [name2…], [value2…], calculation)

where:

 • name1: the name for the first value
 • value1: the value to associate with the first name
 • name2 (optional): additional names for second and subsequent values
 • value2 (optional): additional values for the second and subsequent values
 • calculation: this is the calculation to perform.  This is always the final argument and it can refer to any of the defined names in the LET.

The main benefits of using LET function includes:

 • readability: LET function tracks the changes in defined cells or expression in dynamic way, so there is no need to remember what a specific  
  range / cell reference referred to.  With the ability to define variables, it can provide more meaningful context to end users

 • performance: LET allows named expression in the formula and calculated only once, even if it is referred to many times in the formula.  This  
  can significantly improve performance for complex expressions.

The formula in cell C21 is given by

=LET(BusinessUnit, B3:B15=C17,
SalesPerson, C3:C15=C18,
Selection, BusinessUnit*SalesPerson,
Commission, C19,
SalesAmt, D3:D15,
SUMPRODUCT(Selection*SalesAmt^2)*Commission/SUMPRODUCT(Selection))

Let’s return to our past example.  If we are considering LET, how about 
we use the property rental market!  Suppose we run a company where 
salespeople make commission based upon 1% of the average of the 
square of the weekly rent, e.g. if Annie makes two sales of $400 and $300, 
then the average of the amounts squared would be (3002 + 4002) / 2 = 

125,000 and 1% of that would be $1,250.  Not much incentive to make 
lots of sales, is there?  It’s not my fault she negotiated her contract badly…

Anyway, it’s convoluted, but we are trying to construct an example which 
we cannot simply solve using a standard Excel formula like AVERAGEIFS!
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The final argument is the formula – but more on that shortly.  Before that, there are pairs of expressions where the first element is the name and 
the second is an expression for a value.  Let’s go through all of these arguments (mainly in pairs):

 • BusinessUnit, B3:B15=C17 define the array BusinessUnit, which is an array of TRUE and FALSE values depending on whether the Business  
  Unit is equal to the value in cell C17 (which is “C” in the illustration).  Therefore, we have {FALSE, FALSE, FALSE, FALSE, FALSE, FALSE, FALSE,  
  TRUE, TRUE, TRUE, TRUE, FALSE, FALSE}

 • SalesPerson, C3:C15=C18 generate a similar array (named SalesPerson), which provides TRUE and FALSE values depending on whether the  
  salesperson was Annie.  Therefore, we have {TRUE, FALSE, FALSE, FALSE, FALSE, FALSE, FALSE, FALSE, FALSE, TRUE, TRUE, FALSE, FALSE}

 • Selection, BusinessUnit*SalesPerson now shows the value of LET.  This names the value of the product of the first two parameters Selection  
  without having to write out the formula again and, more importantly, without having to calculate them a second time unnecessarily.  This  
  results in TRUE/FALSE expressions multiplied by other TRUE/FALSE expressions, which results in a one if both are TRUE and zero (0)   
  otherwise.  Therefore, we have {0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 1, 0, 0}

 • Commission, C19 is relatively simple, naming the value in cell C19 (1%) Commission

 • Similarly, SalesAmt, D3:D15 apply the name SalesAmt to the range D3:D15 for the purposes of this formula.  Therefore, we have {374, 347,  
  159, 393, 478, 354, 159, 203, 371, 300, 400, 187, 140}

 • Finally, the formula
  SUMPRODUCT(Selection*SalesAmt^2)*Commission/SUMPRODUCT(Selection) calculates the commission similarly to the approach  
  explained above.  However, Selection, SalesAmt and Commission are merely referenced and neither need to be recalculated nor written out  
  in full.

This may seem verbose, but it speeds up calculation time considerably, and makes formulae easier to read (once you get your head around this 
new approach).  Further, LET only defines the range name within the formula.  These are not general range names in the spreadsheet – Excel will 
not recognise them outside of this LET formula. 

To be crystal clear, there are two key differences between defined range names and this now Generally Available LET function:

 1. LET allows you to see the definition of the name there and then without jumping to the definition elsewhere.  Yes, the formula may be longer  
  in the cell, but the user can hopefully follow it without audit tools

 2. When Excel sees a defined name in a formula, it pauses the current formula, evaluates the defined name's formula to get a result, and  
  returns to the original formula.  A variable defined using LET is only ever evaluated once.

  An example that shows the difference is =LET(x, RANDBETWEEN(1, 1000000), x – x).  This formula will always return zero, since   
  RANDBETWEEN(1, 1000000) gets evaluated and then assigned to x, which never changes, so x – x = 0.

  If you instead use the name manager to define the name x as =RANDBETWEEN(1, 1000000), then entering =x – x is almost never going to be  
  zero, since each x in the formula causes RANDBETWEEN to be evaluated.

It should also be noted that you must be careful with your order of arguments and defining reference names.  Name definitions can only   
make use of prior and not subsequent names.  In the example above, Selection could only be defined once BusinessUnit and SalesAmt had  
both been defined.

Now that it has become Generally Available, there have been some changes made to LET:

 1. Autocompletion of names: if you have defined the name earlier, Excel will now recognise it.  There is now a special icon       indicating that  
  you may autocomplete the formula with the name so identified

	 2.	Allowed names:	due	to	the	rich	Data	Types	also	making	use	of	the	dot	(“.”),	this	character	is	no	longer	legal	in	names	bound	by	LET.		If	you		
	 	 have	already	created	such	naughty	names	in	files	created	during	the	Insider	phase,	the	name	will	be	“silently	upgraded”.		Better	than		
	 	 euthanised,	we	suppose

	 3.	Localisation changes:	localisation	has	now	been	removed	from	the	LET	function.		LET	is	now	the	name	of	the	function	in	all	stockkeeping	units		
	 	 (SKUs)	of	Excel	and	is	no	longer	localised.		LET	it	be.
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Beat the Boredom Challenge

Visual Basics

With many of us currently “working from home” / quarantined, there are only so Zoom / Teams calls you can make before you reach your data limit.  
Perhaps they should measure data allowance in mugs of coffee.  To try and keep our readers engaged, we will continue to reproduce some of our 
popular Final Friday Fix challenges from yesteryear in this and upcoming newsletters.  One suggested solution may be found later in this newsletter.  
Here’s this month’s…

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  This 
month, we consider how to set up events to trigger on saving a file.

Near the end of the year, we usually find ourselves creating quarterly 
reports and sending them off to head office.  And that may cause issues.

Have you ever been told by head office that they want all of the charts 
on a worksheet to have the same axis ranges, but you can’t use a macro 

as it is against company policy?  Hoping to find a solution, you navigate 
to trusty Google and only find answers that involves said prohibited 
automation? 

We’re going to start off by reusing some of the code that we used last 
month.  Remember we created a Disclaimer macro that would run when 
the file is open?  What happens if the person opening the file simply 
doesn’t enable macros?

This is where Workbook_BeforeSave comes in handy.  Instead of running 
some sort of disclaimer that hides everything when the model is opened, 
why not run it instead just before we save the file?  That way, when 

we save the file, before it saves, it will run the Disclaimer, and when 
someone opens the file, sheets will be hidden already.

Of course, that begs the question, once it’s saved, do we need to click 
“I agree” before we can move on?  Well, if we use the Workbook_
AfterSave event, then we can have it unhide again once the file has been 
saved, meaning that we don’t need to lift a finger to reset the file back 
to an ‘unlocked’ status.

Imagine you have the above chart data, and you need to generate the three charts (below) from the table.  The trouble is, we want to have all three 
charts to have the same y-axis values.  

There are two conditions:

 1. the y-axis values have to be dynamic, i.e. they have to change based upon the range of data
 2. this has to be done without the use of a macro. 

Sound easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

(data can change!)

The Challenge
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There are actually some other tools that we can use as part of this 
function.  If someone were to use ‘Save As’, this will transmit that fact to 
a variable called SaveAsUI, which can be used to create some additional 
rules, perhaps some new details that should be incorporated into the file 
to reflect the fact it will be a new file.  You can also see that there is a 
Cancel variable that will check if someone cancels a ‘Save As’ operation, 
as you may not want the macro to run if the file isn’t actually saved.

These are useful tools that can help you manage your files and automate 

processes that you might not trust people to actively do when they save a 
file.  Other useful things to run before saving might include resetting the 
viewable area of worksheets to the top left hand side, changing scenario 
values back to base case values, or other similar “file clean up” activities.

Next month, we’ll take a look at some in-sheet events, such as selecting 
particular cells.  

More next time.

Power Pivot Principles 

Power Query Pointers

We continue our series on the Excel COM add-in, Power Pivot.  This month, we get the introduction right and state we will be discussing managing 
multiple tables.

Each month we’ll reproduce one of our articles 
on Power Query (Excel 2010 and 2013) / Get & 
Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more 
in the meantime, simply check out our Blog section 
each Wednesday.  This month, we look at one way to 
remove blank rows and columns.

The scenario is familiar: a huge Excel table comes in with 
lots of columns and rows, but in some cases a column 
or row is completely empty, and the table needs to be 
condensed.  This may be easy to do by hand for smaller 
tables, but for larger data sets it would be nice to be 
able to do this automatically, at the press of a button.  

For this month’s example, we have imported the Items 
table into Excel and this already has a few empty 
columns.  There also a couple of blank rows: >

As we’ve been going through this series discussing Power Pivot, we’ve been creating measures predominantly in the ‘Sales’ table.  If we look at this 
table in the Power Pivot window, we see that the measures are located at the bottom of each table in the ‘Data View’ mode.  

If this table is deleted, intentionally or unintentionally, all of the measures contained within the table will also be lost. 

A countermeasure that one may take is to create a completely blank table in the data set, which will house all of the measures.  This will allow the 
user to add or remove tables without losing any of the measures in the data set. 

It’s up to you which you do – just be consistent.  At  SumProduct, we acknowledge this approach, but we prefer to house measures in the tables they 
are most closely associated with.

More Power Pivot Principles next month.
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From the ‘Data’ tab, we may go to the ‘Get and Transform’ section and choose the option ‘From Table’.  We then get the following data in the Power 
Query Editor:

In the ‘Home’ tab, there is a section called ‘Reduce Rows’.  The ‘Remove Rows’ option drops down in this section gives us several choices:

In this case, we want to remove the blank rows, so let’s choose this.
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Even though there is a ‘Remove Columns’ option in the ‘Manage Columns’ section, there is no option to remove blank columns.  Instead, we need 
to transform our data first.

In the Transform tab, we have the option to ‘Transpose’, which will treat columns as rows and vice versa.  We’ll choose this.

Now we remove our blank rows again.

A step appears in the ‘APPLIED STEPS’ telling us that it has ‘Removed Blank Rows’ and our row number has reduced.  Now, for the columns:
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The number of ‘rows’ have decreased from 17 to 10, so we may transpose again to reverse our columns and rows to their original configuration.

We can now close and load to the spreadsheet.  One point to note: there 
is a reason why the column names are generic: transposing will lose the 
column names.  Therefore, there is some work required to rename the 
columns, particularly as the blank ones will have disappeared (unless you 
demote the column headers first).

Next month, we will look at another way to remove blank rows and 
columns using the unpivot function.  And this time we will keep the 
column names…

More next month!

Power BI Updates
Here’s an anomaly.  Anomaly Detection is in Preview!  That’s not the only 
new feature in Preview with this update either: the new Field List and 
Model View are also making their debuts.  Power BI Service’s updates 

add endorsements for datasets and dataflows are extended to reports 
and apps, enabling business users to be confident they are making 
decisions based on the right data. 

Here is this month’s list of updates, which seems smaller than usual (!):

Reporting

	 •	New	Field	List	in	Preview
	 •	New	Model	View	in	Preview
	 •	 ‘Apply	all	filters’	is	now	Generally	Available
	 •	Visual	Zoom	Slider
	 •	Data	point	rectangle	select	extended	to	Map	visual
	 •	 Certificate	revocation	check	for	web	connections
	 •	 Paginated	reports	updates

Analytics

	 •	Anomaly	Detection	in	Preview
	 •	Q&A	now	supports	partial	matching	data	values

Data Connectivity

	 •	Hive	LLAP	connector	Generally	Available	

	 •	New	connectors:	
	 	 	 o	 Actian
	 	 	 o	 Anaplan
	 	 	 o	 Starburst	Presto

Developer

	 •	 Power	BI	Automation	and	APIs
	 •	 Fetch	more	data	API	3.4
	 •	 Enhanced	testing	of	your	developed	custom	visual

Visualisations

	 •	New	visuals
	 •	 Zebra	BI	4.4
	 •	New	visual	by	ZoomCharts:	Drill	Down	Map	PRO
	 •	 xViz	Scatter	/	Bubble	chart.

Let’s	take	a	look	at	each	in	turn.
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New Field List in Preview

ICONS AND USER INTERFACE

CONTEXT MENU: FIELD

Microsoft is unifying the field lists across Data, Model and Report views in Power BI Desktop.  This change will create consistency for functionality 
and User Interfaces across views (where applicable), to address end user feedback and anecdotal confusion.

Some of the consistency changes made include:

 • Iconography
 • Search functionality
 • Context menu items
 • Similar drag-drop behaviour
 • ToolTips
 • Accessibility improvements.

Apparently, the aim is to improve Power BI Desktop usability with this change and should have minimal impact on typical data workflows.

For this release, the new Field list will start rolling out to the Model view only.  To activate this, find the Preview feature switch in the Preview options, 
i.e. File -> Options and settings - > Options - > Preview features -> New Field list.

Below is a ‘before-and-after’ comparison of the changes:
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CONTEXT MENU: TABLE

TOOLTIPS

Also, the icons have been updated for the Field list:  

Old Icon New Icon Meaning  

Folders in the Fields list.

Numeric field: Numeric fields are aggregates that can be summed or 
averaged, for example.  Aggregates are imported with the data and defined 
in the data model your report is based upon. 

Calculated column with a non-numeric data type: A new non-numeric 
column you create with a Data Analysis Expressions (DAX) formula that 
defines the column’s values.

Numeric calculated column: A new column you create with a Data Analysis 
Expressions (DAX) formula that defines the column’s values. 

Measure: A measure has its own hard-coded formula.  Report viewers 
cannot change the calculation, for example, if it is a sum, it can only be a 
sum.  The values are not stored in a column.  They are calculated on the fly, 
depending solely upon their location in a visual. 

Measure group.

KPI: A visual cue that communicates the amount of progress made toward a 
measurable goal.
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Old Icon New Icon Meaning  

Hierarchy of fields: Select the arrow to see the fields that make up the 
hierarchy.

Geo data: These location fields can be used to create map visualisations.

Identity field: Fields with this icon are unique fields, set to show all values, 
even if they have duplicates.  For example, your data might have records 
for two different people named ‘Robin Smith’, and each will be treated as 
unique.  They will not be summed.

Parameter: Set parameters to make parts of your reports and data models 
(such as a query filter, a data source reference, a measure definition, etc.) 
depend upon one or more parameter values.

Calendar date field with a built-in date table.

Calculated table: A table created with a Data Analysis Expressions (DAX) 
formula based on data already loaded into the model.  These are best used 
for intermediate calculations and you want to store as part of the model.

Warning: A calculated field with an error.  For example, the syntax of the 
DAX expression might be incorrect.

Group: Values in this column are based on grouping values from another 
column, by using the groups and bins feature.

[None.]
Change detection measure: When you configure a page for automatic page 
refresh, you can configure a change detection measure that is queried to 
determine if the rest of a page’s visuals should be updated.

New Model View in Preview

TABLE CARD HEADERS: HEADER COLOUR

You can use the Model view in Power BI Desktop to view and work with complex datasets that contain many tables.  This month, that Model view 
has a new look.  To use the new look, go to the model view and press ‘Upgrade now’ to use the new look.

Table card headers show colours to help you quickly see which tables are 
from the same kind of source.  All tables that are in import mode will not 
show a colour.  Tables from the same DirectQuery source (blue in the 

image below) will show a colour for tables from that same source.  For 
colour-blind users, they may also learn which tables are from the same 
source by hovering over the table headers to see more details. 
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For tables in dual mode, the header will show a hashed colour to represent that the table is in both import and DirectQuery mode.

TABLE CARD HEADERS: STORAGE MODE ICONS

TABLE CARD HEADERS: ERROR ICONS

Icons have been added to the table headers to help users identify the storage mode that a table is in:

If you have a field that has an error, now you will see an error icon show up next to that field.

Icon Meaning  

Table is in import mode.

Table is in DirectQuery mode.

Table comes from a live connected source.

Table is in dual (both import and DirectQuery) mode.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

TABLE CARD HEADERS: TABLE CARD TOOLTIPS

TABLE CARD HEADERS: COLLAPSE CARD

TABLE CARD HEADERS: TABLE CARD PROPERTIES

When you hover over the table card headers, you will see a ToolTip giving you more details about that table in your model.  For a table that has been 
imported, you can see the name of the table, the storage mode it is in and when the data in that table was last refreshed.

To simplify the look of your model, you can collapse table cards to make them smaller.

You can change how table cards in the Model view display information with card properties.  To see card properties, make sure you do not have a 
table or field selected.

You can also collapse your table cards, but continue to show key fields:

For a table in DirectQuery mode, you can see the name of the table, the storage mode, the type of data source being used, and the server and 
database names.
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TABLE CARD HEADERS: SHOW THE DATABASE IN THE HEADER WHEN APPLICABLE

TABLE CARD HEADERS: SHOW KEY FIELD WHEN CARD IS COLLAPSED

TABLE CARD HEADERS: PIN KEY FIELD ON TOP OF CARD

For tables that have associated database information, you can choose to show this information in the header of your table cards.

If you collapse a card, you can choose to continue to display the key fields for that table.  Key fields are primary or foreign keys of relationships.  In 
the following image, OrderDate, ProdID and StoreKey are key fields of the table Sales:

You can choose to pin key fields of a table to the top of its table card.  

This image shows the fields in the Sales table in alphabetical order, which is the default order for tables and fields in Power BI:

You can also choose to turn this off for a simplified, minimalistic look.
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If you turn on ‘Pin key field on top of card’, the key fields for a table will show up at the top of your table cards.  As you can see in the following image, 
the fields in the Sales table are no longer in alphabetical order because the key fields OrderDate, ProdID and StoreKey have been moved to the top 
of the card:

PERFORMANCE VIEW

Microsoft has also made some performance improvements to the Model view.  If you have a large model (more than 50 tables), instead of trying to 
show all your tables and hitting performance errors, Power BI will load and let you decide the layouts that you would like to work with.
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‘Apply all filters’ is now Generally Available

We finally get to the third feature!

The ‘Apply all filters’ feature is now Generally Available.  As a reminder, 
this feature was introduced to help optimise the Filter pane for query 
reduction by applying all filter changes at once.  Previously, you had two 
options for filter queries: apply basic filters instantly (the default option) 
or add an ‘Apply’ button to each basic filter.  The first option to apply 
the basic filter instantly is ideal for those who prefer instant interactivity 
over query reduction.  The second option, which added an ‘Apply’ button 
to each Filter card, optimised for query reduction instead.  However, it 

required an additional click every time you needed to apply a filter.

In May, Microsoft released a Preview of an ‘Apply all filters’ option to add 
a single ‘Apply’ button to the Filter pane, essentially allowing you and 
your end-users to apply all filter modifications at once.  This capability is 
useful if you want to defer when to apply filter changes, so that you only 
have to wait once after you are ready to apply any filter changes to the 
report or visuals.

You may now set this feature at a report-level; however, the feature will be off by default.

You can turn on this option in Power BI Desktop by going to File -> Options and settings -> Options -> Query reduction -> Filters and selecting the 
option to ‘Add a single Apply button to the filter pane to apply changes at once’.
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As part of this General Availability release, a few usability improvements have been made too:

 • You can now change the fill colour for the ‘Apply’ button in the Filter pane tab of the Format pane:

	 •	 You	can	also	specify	the	colour	in	the	theme	itself:

	 •	 The	behaviour	for	the	Clear	filter	has	been	modified.		Previously,	if	you	hit	‘Clear	filter’,	the	action	would	be	instant	instead	of	deferred,	like		
	 	 other	filter	modifications.		Now,	when	you	hit	the	‘Clear	filter’	icon,	Power	BI	will	only	clear	the	filter	when	you	hit	the	‘Apply’	button		
	 	 on	the	Filter	pane.

Visual Zoom Slider

Zoom sliders have now been added to Cartesian charts.  These sliders 
give report creators and users a simple way to examine a smaller range 
of the data in a chart without having to use a filter.  Further, using 
zoom sliders will not affect contextual information, such as calculated 
trendlines.

To use a zoom slider, simply click and drag endpoints to adjust the 
dimensions of the view window.  Then, click and drag the bar between 
them to pan that window around. 
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You can enable zoom sliders in their card in the Formatting pane of  the supported visuals.  There are also a few other options:

The X and Y axis toggles enable or disable the zoom slider for each axis.  
The slider labels toggle enables a new row of labels next to the slider 
indicating the full range of the data, and the slider ToolTips toggle makes 
ToolTips appear as you click and drag each endpoint, showing you the 
value of your selection as you work with the slider.

The zoom state of your visual will also be saved when you save and 

publish your report.  When end users open the report, the endpoints of 
the zoom slider will default to whatever you have saved, allowing you to 
highlight a specific window of data while keeping its context immediately 
accessible.

Zoom sliders are to be enabled for bar / column, line, line and bar / 
column combination, and scatter charts.

Data point rectangle select extended to Map visual

Certificate revocation check for web connections

This update sees the data point rectangle select Preview feature extended to the Map visual.  Now, users may click and drag across maps to create 
a selection rectangle, allowing them to easily select multiple points at once. 

The security of web connections has been strengthened to protect your 
data.  However, this means that certain scenarios, like capturing web 
requests with Fiddler, will no longer work by default (bang goes our 
trick for referencing multi-page data from a website with a single URL 
– please see https://www.sumproduct.com/thought/referencing-multi-

page-data-from-a-web-site-with-a-single-url).  To enable those scenarios, 
uncheck the ‘Enable certificate revocation check’ in the Security pane 
in the Options dialog and then restart Power BI Desktop.  Obviously, 
unchecking that box will make web connections less secure.
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Paginated reports updates

PAGINATED REPORT SAMPLE REPORTS

Microsoft has now provided paginated report samples for you to download and try out in the Power BI Service.  Details may be found at  
https://docs.microsoft.com/en-us/power-bi/paginated-reports/paginated-reports-samples#download-the-reports. They reflect several typical 
scenarios you might use paginated reports in, including:

 • an operational report around sales performance
 • an invoice generated for a customer
 • a course transcript
 • mailing labels
 • a formal receipt mailed to a customer.

DOWNLOAD CONNECTED PAGINATED REPORT FROM A POWER BI DATASET

SEARCH IN PARAMETER DROPDOWNS IN POWER BI

To help get started building a paginated report against a Power BI 
dataset, the Power BI team has added the ability to download the 
RDL file from the Power BI service with the connection information 

already defined for the selected Power BI dataset.  Simply choose any 
Power BI dataset in the Service you have access to and right-click on the 
dataset.  You will see the option to ‘Download the .rdl’.

This update has also addressed one of the top usability issues related to 
parameter dropdowns in the Power BI Service.  You may now use a fuzzy 

text search to better filter the value you are looking for, so you do not 
have to scroll through a long list to get the selected item.  
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PAGE VIEW MODE URL PARAMETER

POWER AUTOMATE ACTIONS FOR EXPORTING POWER BI AND PAGINATED REPORTS

Anomaly Detection in Preview

You can pass ‘rdl:reportView=pageView’ as part of a URL to configure the look and feel of your paginated reports in Power BI and render the report 
in page view mode instead of interactive. 

You may easily leverage the Power BI export API for either Power BI 
reports or paginated reports in your Power Automate workflows.  These 
new actions make it easy for anyone to quickly export their Power BI 
content in a variety of supported formats and scenarios.  Want to have a 
Power BI report saved to OneDrive every day at noon as a PDF, or have 

different reports mailed to everyone on your team in different formats?  
No problem.  Have a Power App using the Common Data Service and 
want to print an invoice from it using paginated reports?  You can do 
that now too…

Anomaly detection helps you enhance line charts by automatically 
detecting anomalies in your time series data.  It also provides explanations 
for the anomalies to help with root cause analysis.  With just a couple of 
clicks you can easily find insights without slicing and dicing the data.

Since this feature is in Preview, you will first need to turn on the feature 
switch by going to File -> Options and Settings -> Options -> Preview 
features and make sure ‘Anomaly detection’ is turned on:

Once you enable ‘Anomaly detection on a chart’ by adding ‘Find Anomalies’ from the ‘Analytics’ pane, it gets automatically enriched with the 
anomalies and expected range of values.
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This experience is highly customisable, whereby you may configure the sensitivity of the algorithm, shape, size, colour of the anomaly, and the 
colour, style and / or transparency of the expected range.

Once you select the anomaly, Power BI runs an analysis across the fields in your data model to figure out possible explanations.  The Anomalies pane 
provides a natural language explanation of the anomaly and associated factors sorted by their explanatory strength.

You can control the fields that are used for analysis by dragging fields into the ‘Explain by’ field well.  Clicking on an explanation opens the card where 
you can see more details of the explanation.  You can also add the explanation visual to the report.
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Report consumers can view anomalies and explanations after the creator publishes the report to the Power BI Service.

Q&A now supports partial matching data values

Hive LLAP connector Generally Available

Q&A now supports a much-requested feature: ‘partial matching for data 
values’.  Prior to this update if you typed in ‘show me sales for Azure’, 
the question would fail because the actual value is ‘Microsoft Azure’.  

With this new update, we will now return you intelligent matches by 
searching the data for more than just exact matches.  You can feel Fuzzy 
all day long!

The Hive LLAP connector in now Generally Available.  It has also been added to the On-Premises Data Gateway.

This connector provides both Import and Direct Query capabilities and the ability to specify ‘Thrift Transport Protocol’ as ‘Standard’ or ‘HTTP’.

This connector can be found in the ‘Other’ category of the ‘Get Data’ dialog:
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New connectors

ACTIAN

ANAPLAN

STARBURST PRESTO (Beta)

Actian Avalanche is a fully managed platform with a hybrid cloud 
data warehouse.  The cloud data warehouse was designed to deliver 
performance and scale, powered by a vectorised database engine 
(whatever that means!).  Using ODBC and / or JDBC connectivity, users 
of Avalanche can easily connect Power BI to an Avalanche cloud data 

warehouse.  You will be able to find this connector in the ‘Database’ 
category.

To download the Avalanche client drivers, please use the following link: 
https://esd.actian.com/.

The Anaplan Connector for Power BI is a user-friendly native connector for Power BI.  It allows you to easily connect Anaplan data and models to Power 
BI.  The connector lets you load export actions saved within Anaplan models directly into Power BI.  Find this connector in the ‘Other’ category.

Starburst Data provides accelerated data analytics at scale with Power 
BI.  The Power BI DirectQuery driver can be used to connect Microsoft 
Power BI Desktop and Microsoft Power BI Service to Starburst Enterprise.  

It allows users to connect Power BI with Starburst’s distribution of 
Presto.  This combination enables the query processing to be performed 
in Presto, instead of moving data to Power BI for processing. 
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The ANSI SQL MPP query engine offers quick access to massive volumes of 
complex data at source (consolidated or federated).  Power BI leverages 
that single point of access to data anywhere and enables users to analyse 
the data to make informed business decisions in real time.  Starburst 

Enterprise includes numerous high-performance parallel connectors 
with global security, caching, autoscaling, cost-based query optimiser, 
and 24×7 support from Presto experts.  This connector is again in the 
‘Other’ category.

Certified and Promoted reports and apps

‘New look’ of the Power BI Service is now live

Power BI Automation and APIs

Fetch more data API 3.4

Organisations are increasingly seeking to build a data culture so they can 
leverage insights every day, at all levels of their company, across users 
with a variety of analytical skillsets.  

To encourage the use of standardised data, Microsoft had previously 
released endorsement for datasets and dataflows.  This capability was 
designed to help report creators who need to find authorised data to build 
their reports on.

This update now extends this capability to provide similar endorsement 

capabilities for reports and applications.  This will enable business users to 
be confident they are making business decisions based on the right data.

With certification, Power BI is providing organisations with a mechanism 
they can use to distinguish their most valued and trusted content.  
Content certification can be tightly controlled and documented via an 
administrative control, ensuring that certification is a selective process 
that results in the establishment of truly reliable and authoritative body of 
content designed for use across the entity.

All the improvements of the ‘new look’, from navigation updates to the 
simplified action bar for reports and dashboards, have been fully released 
to all tenants and users.  Microsoft has stated that they have “…made 

incremental updates to modernize (sic) and simplify the Power BI [S]
ervice…” from feedback gleaned during the Preview phase.

The new Power BI API for Reports allow report creators to transfer the 
ownership of paginated report data sources to authorised users who call 
the API.  For instance, to update the details of a data source, you must be 
the owner of the data source.  The ‘Take over API for paginated reports’ 

will help users take ownership of the source to allow access to update it.

The new API will be the equivalent of the existing API, ‘Datasets – Take 
over in group’, which allows users to transfer ownership of a dataset for 
Power BI reports.

The ‘Fetch more data API’ enables custom visuals to bypass the hard 
limit of a 30,000 rows data view when additional data is needed.  With 
the new 3.4 API release, Power BI has extended the ‘Fetch more data’ 
API’s functionality to support a new approach of loading data chunks.  

In addition to the existing approach which aggregates all the chunks 
requested, the API now supports loading only incremental data chunks.  
The new approach allows more flexibility in the way additional data 
chunks are loaded to the visual.

For those of you that has missed the key ‘new look’ improvements, here’s a quick recap:

 • Simplified action bar: The action bar has been made simpler and been better organised so it is easier to find related actions and putting most  
  common actions front and centre
 • Page navigation settings: Report authors can choose where report page navigation sits, on the left as a pane or across the bottom as tabs
 • Minimise global navigation and collapse left page navigation: To give you more room to view and interact with your reports, Power BI has  
  updated interactions to minimise the global navigation and collapse the left pages navigation
 • New workspaces: Easier to scan, find what you need, get data, search, take quick actions, etc.
 • Updated personal bookmarks: Previously, selecting a personal bookmark would update the bread crumb in the top bar with the name of the  
  bookmark.  Moving forward, the bookmark name will be updated inline within the context of your report action bar
 • View report details: See details such as last refresh date and contact information quickly, right in the top banner
 • Vertical list of pages: Report page names are now in a list in a vertical pane.  They are prominent, hard to miss, and like navigation in Word and  
  PowerPoint
 • Improved filter experience: Updates such as viewing applied filters and the new Filters pane are available by default with the ‘new look’
 • Dashboard experience: Dashboards also have a simplified action bar, just like reports and apps, for a consistent experience, while retaining the  
  functional differences.

With ‘new look’ released to all tenants and users, the user-facing ‘New look on’ toggle has now been removed from the header.

As Power BI becomes widely adopted across your organisation, you can see 
that many reports are available.  Often, multiple similar reports exist, with 
major overlap between them, making it difficult to find the right report 
one can use and be sure of.  Any content owner (a user with an admin / 

member / contributor role in the workspace) can promote their content, 
thereby marking it as trusted and ready to be shared.  This promoted 
content will get better visibility in a variety of Power BI experiences, 
making it easier for business users to find and identify.
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There are various new visualisations to check out this month:

 • Forecast visual by Predmac
 • Global Launch Estimated by TheraTraq
 • Lollipop Column Chart by Nova Silva
 • Dynamic KPI Card by Sereviso
 • Shielded HTML Viewer by Nova Silva
 • TheraTraq Timeline Circle by TheraTraq
 • Workforce by TheraTraq.

We look at three (not mentioned above) in more detail below.
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Enhanced testing of your developed custom visual

New visuals

Zebra BI 4.4

FREEZE OR UNFREEZE CATEGORIES (ROW HEADERS)

MULTI-LEVEL HIERARCHICAL CHARTS

This update adds a new feature that enables developers to override the AppSource published visual version with a local file version in both Power BI 
Desktop and Service.  This is used when developers want to test or debug a local version of a visual that is already published in AppSource.

The latest update of Zebra BI visuals for Power BI (version 4.4) introduces a few new ideas and addresses frequently requested features.  Major changes 
such as multi-level hierarchical charts and custom fonts, as well as the ability to freeze row headers in tables, 1-click experience of Top N + Others, 
support for Analytics pane, additional fields for ToolTips and new design options for a sleeker look.

The key improvements in Zebra BI Tables are detailed below.

If you freeze the row headers (first column), it locks them into place.  This is very practical for use with data-heavy table or matrix displays:

Hierarchical charts are quite a challenge in data visualisation because of 
the scaling issue with higher levels on the hierarchy being much larger 
than all other levels below that.  But now, Zebra has found a more natural 
way to display the contribution of each level lower on your hierarchy.  

Here is an example with a vertical waterfall chart.  As you can see, it makes 
it clearer to understand how each business unit contributes to the total 
bottom line of each division:
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This solution works especially well in P&Ls (income statements).  In a hierarchical P&L, you can dynamically expand / collapse certain subtotals as 
needed, e.g. revenue, COGS or Opex:

1-CLICK TOP / BOTTOM N

ANALYTICS PANE

Filtering tables with the Top N feature has now been improved.  It is now easier to change the number of Top N elements you wish to see.

The Analytics pane is one of those Power BI features that too often gets 
overlooked but is hiding some useful powers.  It enables you to simply add 
certain calculated elements, e.g. average, median, constant and percentile 

to your tables.  You can for example set the benchmark and it will be 
displayed on the table (see the yellow line below):

This feature is rolled out across hierarchies.  You can turn the Top N on or off separately for any level in your hierarchy. 
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PERFORMANCE IMPROVEMENTS

SLEEKER AXIS LABELS IN SMALL MULTIPLES

There are reportedly other features and improvements in the Zebra BI Tables visual that will improve the design and usability of your Power BI 
reports and dashboards, with speed improvements reported of 15 – 25% (albeit measured by Zebra BI).

Zebra BI Charts (version 4.4) has been updated too…

1-CLICK TOP N + OTHERS

From now, you can change the number of charts 
displayed with one simple click.  Even users may 
increase or decrease the number of charts: >

When you change the number of charts, everything 
else is still automatically calculated in the  
‘Other’ chart.

Zebra BI’s small multiples follow a minimalistic concept.  However, this version improves legibility.  You can now control the density and the number 
of axis labels.

This is important because in a typical small multiple there can be a lot of redundancy in data labels.  Now there are more options, e.g. to display only 
labels in the first chart, only on the first row, or on the last row only.  See the example below:

Even if the charts are larger and users need to scroll up and down, your labels on the bottom will stay frozen and help users understand which 
categories they are looking at.
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ADDITIONAL FIELDS FOR TOOLTIPS

SWITCH COMPARISON SCENARIOS

UP-TO 11 LAYERS

FILTERING USING CUSTOM SHAPES

New visual by ZoomCharts: Drill Down Map PRO

ToolTips make reports more understandable for people who read them.  From this update, there are now additional data fields in your data ToolTips.  
When users hover over certain values, they will be able to see additional information for each data point, including text comments.

If you have multiple comparisons in your Zebra BI Charts visual, you can now choose the order in which they are displayed:

Use Microsoft Azure Maps or a custom tile server of your choice (e.g. OpenStreetMap) as the base layer.  Add additional shape layers on top of that 
using either built-in shapes or add your own by specifying KML / GeoJSON sources.  Each layer can be bound to specific zoom levels to enable dynamic 
drill down experience.

Use built-in shape layers (e.g. countries, states), create your own custom shapes (the lasso tool) or import shapes from KML / GeoJSON files and use 
the shapes to aggregate and filter your data.  Custom shapes can be saved in the visual within the report to enable your end users to use them for 
data exploration purposes.

Drill Down Map PRO by ZoomCharts may be used to create maps with 
built-in filters (such as countries and states) or create and store your 
own filters for custom regions.  Features include data clusters as do(ugh)

nut charts and multi-page ToolTip enables you to show more data per 
location in a structured, user-friendly way. 

The main features are:
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CLUSTER THE DATA USING THE BUILT-IN DRILL DOWN DONUT PRO VISUALS

When grouping data in clusters based upon their location and proximity, you can turn them into donut charts to visualise the content of the cluster; 
data will be automatically grouped by the category field.  Slices act as category filters.

MULTI-PAGE TOOLTIPS FOR CLUSTERED NODES

Multi-page ToolTips solve the problem of showing additional information for each data point within the cluster.  You can browse information for all 
related nodes within one ToolTip, using navigation arrows.

RICH CUSTOMISATION OPTIONS

As all ZoomCharts custom visuals, Drill Down Map PRO comes with plenty 
of formatting options.  There are multiple node shapes to choose from as 
well as image support for nodes.  You can add auras, assign a different 

color for each node category, adjust node sizes, fonts and labels.  Visual 
also fully supports measures, drill-through and report page ToolTip.
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Drill Down Map PRO is useful for visualising environmental, sociodemographic and health data, mapping sales and marketing data or monitoring 
production and equipment data by site location (e.g. drilling or mining sites). 

xViz Scatter / Bubble chart

The xViz Scatter/ Bubble chart provides nine (9) quick-start templates, 
including Scatter, Bubble and an International Business Communication 
Standards (IBCS) variation for both.  A Scatterplot chart displays the 
relationship between two numerical values (X and Y coordinate), and 
ideal for correlation analysis and outlier detection.  The Bubble chart 
further enhances the Scatterplot’s information density by adding a 
size variable as a third dimension.  You can also pack more information 

by using color as the fourth variable, either value or category, with 
conditional formatting.

The category fields are used for labelling the bubbles and activate drill 
down mode when more than one.  The legend field further splits the 
bubbles into different groups, which can be styled with specific colours, 
shapes, patterns and custom images under the Appearance tab.

Several key features have been addressed as below:

 • robust conditional formatting for outlier detection
 • IBCS standard templates for Bubble and Scatter
 • variance bar for strategic use cases
 • data label customisation: display category and value for each   
  data point
 • analytics section: custom lines, trend lines, reference lines and  
  bands

  
 • runtime options: ranking with ‘Others’, zoom in / out, lasso and  
  reverse lasso
 • annotations for enhanced storytelling
 • Bubble customisation: shape, size, pattern and custom images  
  (Data URI)
 • axis ranges for grouping the axes into different bands.

More next month we’re sure!
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The A to Z of Excel Functions: FILTER
No longer in Preview mode, i.e. it’s now Generally Available to Office 365 users, FILTER is one of seven functions heralding the new dawn of arrays 
– the Dynamic Array.  

Before explaining FILTER, let’s first consider what a Dynamic Array is.  Consider the following data:

If I were to type =F12:H27 into another cell, Excel in the past would have thought I had gone mad.  I’d need to wrap it in an aggregation function such 
as SUM, COUNT or MAX, to name but a few.  Otherwise, I would have to wrap it in braces using CTRL + SHIFT + ENTER and use it as an array formula.

But no more.

Look at what happens when I type =F12:H27 into cell F33:

The formula automatically extends to three columns by 16 rows!  It has 
spilled.  Get used to the vernacular.  There’s a reason this article got the 
name it did!

Any formula that has the potential to return multiple results can be 
referred to as a Dynamic Array formula.  Formulae that are currently 
returning multiple results, and are successfully spilling, can be referred 
to as Spilled Array Formulae.

Notice I did not have to highlight all of the cells F33:H48.  It spilled.  Also 
take note I formatted cell F33 – er, that didn’t spill, because presently 

formatting isn’t propagated.  This is why this is not yet Generally 
Available.  Microsoft is still trying to work out what should and shouldn’t 
be allowed to happen in this first release.  But don’t let that put you off.

And don’t let this basic example put you off either.  If you feel a general 
sense of underwhelm coming over you, it’s because I haven’t yet 
communicated how powerful this all is as my example was too basic.

However, before I carry on there is a question I do need to cover with 
my far too simple example: what happens if something gets in the way?
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In this example, in cell G40, I have typed in the obtrusive text, “I’m in the way”.  And it quite literally is.  Consequently, I have generated the brand 
new #SPILL! error.  The formula cannot spill, so the error message is generated accordingly. 

#SPILL! Errors

#SPILL! errors are returned when a formula returns multiple results, and Excel cannot return the results to the spreadsheet.  There are various 
reasons an #SPILL! error could occur:

 • spill range is not blank: as in my example (above), this error occurs when one or more cells in the designated spill range are not blank and  
  thus may not be populated.  

	 When	the	formula	is	selected,	a	dashed	border	will	indicate	the		
	 intended	spill	range.		You	may	select	the	error	“floatie”	(believe		
	 it	or	not,	this	is	what	Microsoft	call	these	things!),	and	choose	the		
	 ‘Select	Obstructing	Cell’	option	to	immediately	go	the	obstructing		
	 cell.		You	can	then	clear	the	error	by	either	deleting	or	moving			
	 the	obstructing	cell's	entry.		As	soon	as	the	obstruction	is	cleared,		
	 the	array	formula	will	spill	as	intended	

•	 the range is volatile in size: this	means	the	size	is	not	“set”	and		
		 can	vary.		Excel	was	unable	to	determine	the	size	of	the	spilled		
		 array	because	it's	volatile	and	resizes	between	calculation	passes.			
		 For	example,	the	new	function	SEQUENCE(x)	generates	a	list	of		
		 x	numbers	increasing	by	1	from	1	to	x.		That’s	fine,	but	the		
		 following	formula	will	trigger	this	#SPILL!	error:

=SEQUENCE(RANDBETWEEN(1,1000)).

	 Dynamic	array	resizes	may	trigger	additional	calculation	passes		
	 to	ensure	the	spreadsheet	is	fully	calculated.		If	the	size	of	the			
	 array	continues	to	change	during	these	additional	passes	and		 	
	 does	not	stabilise,	Excel	will	resolve	the	dynamic	array	as	#SPILL!			
	 This	error	type	is	generally	associated	with	the	use	of	RAND,		 	
	 RANDARRAY	and	RANDBETWEEN	functions.		Other		 volatile		 	
	 functions	such	as	OFFSET,	INDIRECT	and	TODAY	do	not	return			
	 different	values	on	every	calculation	pass	so	tend	not	to	generate		
	 this	error

•	 extends beyond the worksheet’s edge: in	this	situation,	the		 	
	 spilled	array	formula	you	are	attempting	to	enter	will	extend		 	
	 beyond	the	worksheet's	range.		You	should	try	again	with	a		 	
	 smaller	range	or	array.		For	example,	moving	the	following		 	
	 formula	to	cell	A1	will	resolve	the	error,	and	the	formula	will		
	 spill	correctly
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	 •	 Table formula:	as	I	will	explain	shortly,	Tables	and	Dynamic	Arrays	are	not	yet	best	friends.		Spilled	array	formulae	aren't	supported	in	Excel		
	 	 Tables	(generated	by	CTRL + T).		Try	moving	your	formula	out	of	the	Table,	or	go	to	Table Tools -> Convert to range

	 •	 out of memory:	I	have	forgotten	what	this	one	means.		Sorry,	I	couldn’t	resist	that.		The	spilled	array	formula	you	are	attempting	to	enter		
	 	 has	caused	Excel	to	run	out	of	memory.		You	should	try	referencing	a	smaller	array	or	range

	 •	 spill into merged cells:	spilled	array	formulae	cannot	spill	into	merged	cells.		You	will	need	to	un-merge	the	cells	in	question	or	else	move	the		
	 	 formula	to	another	range	that	doesn't	intersect	with	merged	cells.

When the formula is selected, a dashed border will indicate the intended spill range.  You can again select that wonderfully named error 
floatie and choose the ‘Select Obstructing Cell’ option to immediately go the obstructing cell.  As soon as the merged cells are cleared, the 
array formula will spill as intended
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	 •	 unrecognised / fallback error:	the	“catch	all”	variant.		Excel	doesn't	recognise,	or	cannot	reconcile,	the	cause	of	this	error.		Here,	you	should		
	 	 make	sure	your	formula	contains	all	of	the	required	arguments	for	your	scenario.

Returning to Dynamic Arrays

Now that we have considered what happens if you block a Dynamic Array, let me now turn my attention to what happens if you don’t.  You get the 
following:

Do you see I am not having to anchor cells (i.e. use dollar [$] signs)?  The formula just spills.  Let me be clear.  If I select cell F34, I get the following:

Here’s a first.  Check out the formula in the formula bar.  It’s greyed out.  Ever seen that before?  Effectively, cell F34 contains the value ‘Triangle’ but 
it does not actually contain an “Excel” formula in the usual sense.  To demonstrate this, let me show you the VBA Immediate Window:
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If you select cells F33:H48 and use ‘Go To Special’ (F5 -> Special), and 
then select ‘Formulas’, cells F33:H48 are shown as formula cells.  You can 
even copy and paste them as values.  Ladies and gentlemen, welcome to 
this brave new world.

Once you have a Dynamic Array, referring to it is simple using what is 
known as the Spilled Range Operator.  For example, if I want to refer 

to the Dynamic Array in the previous examples, it initially had a range 
of L57:N72.  However, once I had added a row and column to the Table, 
this resized to L57:O73.  I can easily refer to this array, whatever its size 
as follows.  In its initial state:

The formula =L57# allows for variations – you simply type in the top left-hand cell reference (i.e. the cell with the non-greyed out formula) and add 
‘#”, known as the Spilled Range Operator.  Simple!

FILTER Function

With the above borne in mind, the FILTER function will accept an array, allow you to filter a range of data based upon criteria you define and return 
the results to a spill range.

The syntax of FILTER is as follows:

=FILTER(array, include, [if_empty]).

It has three arguments:

 • array: this is required and represents the range that is to be filtered
 • include: this is also required.  This specifies the condition(s) that must be met
 • if_empty: this argument is optional.  This is what will be returned if no data meets the criterion / criteria specified in the include argument.   
  It’s generally a good idea to at least use “” here.
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For example, consider the following source data:

To begin with, I will perform a simple FILTER:

Here, in cell F36, I have created the formula

=FILTER(F12:I27,G12:G27=G33,”Not Located.”)

F12:I27 is my source array and I wish only to include shapes (column G12:G27) that are ‘Triangles’ (specified by cell G33).  If there are no such shapes, 
then “Not Located.” is returned instead.  To show this, I will change the shape as follows:
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That is about as basic as it gets.  I can get cleverer.  Consider the following example:

I have repeated the source array (cells F48:I63) for clarity.  The formula

=FILTER(F48:I63,(G48:G63=G69)*(H48:H63=G70),{"-","None","N/A","N/A"})

looks horrible to begin with, but it’s not quite as bad as it appears upon further scrutiny.  The include argument,

(G48:G63=G69)*(H48:H63=G70)

contains two conditions.  Firstly, G48:G63=G69 means that the ‘Shape’ (column G48:G63) has to be a ‘Triangle’ (cell G69) and that the ‘Colour’ 
(column H48:H63) has to be ‘Red’ (cell G70).  The multiplication operator (*) is used to denote AND.  The Excel function AND cannot be used with 
arrays – this is nothing special to Dynamic Arrays; AND does not work with CTRL + SHIFT + ENTER formulae either.  This syntax is similar to how you 
would create AND criteria with the SUMPRODUCT function, for example.

Consider the final argument: {"-","None","N/A","N/A"}.  The braces (typed in!) are used to create an array argument that specifies what should be 
written in each column should there be no record that meets both criteria, e.g.

See?  Not as bad as you might first think.
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My final example is very similar:

Once you realise I have simply repeated referencing for clarity, the formula

=FILTER(F84:I99,(G84:G99=G105)+(H84:H99=G106),{"-","None","N/A","N/A"})

is nothing more than the OR equivalent of the previous example, with ‘+’ replacing ‘*’ to switch from ensuring both conditions are met to only one 
condition being met.  As at the time of writing, XOR is not catered for, but I am sure some clever person will create an equivalent in due course (if 
Microsoft doesn’t beat them to it), necessity being the mother of invention and all that jazz.

Dynamic Arrays vs. Legacy Array Formulae

Finally, prior to this new functionality, if you wanted to work with ranges in Excel, you used to have to build array formulae, where references 
would refer to ranges and be entered as CTRL + SHIFT + ENTER formulae.  The main differences are as follows:

 • Dynamic Array formulae may spill outside the cell bounds where the formula is entered.  The Dynamic Array formula technically only exists  
  in the cell in the top left-hand corner of the spilled range (as shown earlier), whereas with a legacy CTRL + SHIFT + ENTER formula, the  
  formula would need to be entered in the entire range

 • Dynamic arrays will automatically resize as data is added or removed from the source range.  CTRL + SHIFT + ENTER array formulae will  
  truncate the return area if it's too small, or return #N/A errors if too large

 • Dynamic array formulae will calculate in a 1 x 1 context

 • Any new formulae that return more than one result will automatically spill.  There's simply no need to press CTRL + SHIFT + ENTER

 • According to Microsoft, CTRL + SHIFT + ENTER array formulae are only retained for backwards compatibility reasons.  Going forward, you  
  should use Dynamic Array formulae instead

 • Dynamic array formulae may be easily modified by changing the source cell, whereas CTRL + SHIFT + ENTER array formulae require that the  
  entire range be edited simultaneously

 • Column and row insertion / deletion is prohibited in an active CRL + SHIFT + ENTER array formula range.  You first need to delete any existing  
  array formulas that are in the way

 • But remember, this function is only available to Office 365 subscribers still.  Even if you have access to Excel 2019, you cannot use FILTER.
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The A to Z of Excel Functions: FILTERXML

This function should not be confused with FILTER!

Until Excel 2013, Excel was mostly an offline application, although you could use VBA, Power Query / Get & Transform or Power Pivot in Excel to gain 
access to internet and online datasets.  However, Excel 2013 changed all that and introduced two new functions to the world:

 1. WEBSERVICE, which provides immediate and easy access to any REST WebAPI assuming you have an internet connection by downloading the  
  HTTP response of the provided URL;  and 

 2. FILTERXML, which parses an XML string (i.e. a text string that contains an XML document) and returns a single element (known as a node  
  or attribute) provided by an XPath.  In case you are wondering, XPath is a query language for selecting XML elements such as nodes and  
  attributes and works with both XML and HTML.

Therefore, FILTERXML tends to work in tandem with WEBSERVICE insofar that it makes sense of the long text string delivered by the former 
function and finds what you are looking for in that text string. 

The FILTERXML function employs the following syntax to operate:

FILTERXML(xml, xpath)

The FILTERXML function has the following arguments:

 • xml: this is required and represents a string in a valid XML format
 • xpath: this is also required. This represents a string in a standard XPath format.

It should be noted that:

 • if xml is not valid, FILTERXML returns the #VALUE! error value
 • if xml contains a namespace with a prefix that is not valid, FILTERXML returns the #VALUE! error
 • the FILTERXML function is not available in Excel Online
 • the FILTERXML function is not available in Excel (2016) for Mac
 • Further, this function may appear in the function gallery in Excel for Mac, but it relies on features of the Windows operating system, so it will  
  not return results on a Mac.

Please see our example below: 

More Excel Functions next month…
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Beat the Boredom Suggested Solution
Earlier in the newsletter, we looked at three charts that pulled data from the same table.  However, there was no easy way to format the y-axis on 
all three charts so that they all share the same range, without using a macro. 

The Guns and Roses charts have a maximum y-axis range of 80, but the Drugs chart has a maximum of 120.  We want all three charts to have the 
same range.  How do we do this?

The new column has the following formula: 

=MAX($D$14:$F$17)

This will allow us to update the range of the graphs dynamically based upon changing quarterly numbers. 

The next step is to include the ‘Max’ column in each of the charts, we do this by right-clicking the charts and then selecting the ‘Select Data…’ option. 

A Suggested Solution

The first step is to create a new column in the table that retrieves the maximum value:
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The ‘Select Data Source’ dialog box will appear:

Click on the ‘Add’ button, to add the Max column into the chart.  Once you have included the Max column into each chart, they will have two columns 
for each quarter, similar to the ‘Guns’ chart featured below.

The trick here is to select the Max (red) data series and choose the ‘Format Data Series…’ option, and adjust the ‘Series Overlap’ option to 100%.

Now to get rid of the columns, adjust the ‘Fill’ and ‘Border’ settings to ‘No fill’ and ‘No line’ respectively.
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The final step is to remove ‘Max’ from the legend. Double click it then hit ‘Delete’ on your keyboard!

Another trick to incorporate, in case those pesky headquarters staff continuously suggest changing chart titles, is to use a formula to decide the chart 
titles.  Click on each chart title and typing in the formula in the formula bar accordingly, for instance the ‘Guns’ chart should be linked to:

=Charts!$E$10

This works for simple formula references on the same sheet only.  Now, all three charts will not only have consistent but dynamic axes ranges, but 
also have self-updating chart titles. 

So there you have it, charts that will dynamically update based on table data, all with the same y-axis ranges!

Until next time.
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Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 9 - 11 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 16 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 17 - 18 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 14 - 16 Dec 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Power Pivot, Power Query and Power BI 4 - 6 Jan 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 11 Jan 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 12 - 13 Jan 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 15 - 17 Feb 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 22 Feb 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 23 - 24 Feb 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 7 - 9 Apr 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 14 Apr 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 15 - 16 Apr 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 10 - 12 May 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 17 May 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 18 - 19 May 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 15 - 17 Jun 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 22 Jun 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 23 - 24 Jun 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 19 - 21 Jul 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 26 Jul 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 27 - 28 Jul 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 23 - 25 Aug 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 30 Aug 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 31 Aug - 1 Sep 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 29 Sep - 1 Oct 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 06 Oct 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 7 - 8 Oct 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 3 - 5 Nov 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 10 Nov 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 11 - 12 Nov 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 8 - 10 Dec 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 15 Dec 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 16 - 17 Dec 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
·  Business planning
·  Building three-way integrated   
	 financial	statement	projections
·  Independent expert reviews
·  Key driver analysis
·		 Model	reviews	/	audits	for	internal		 	
	 and	external	purposes
·		 M&A	work
·		 Model	scoping
·		 Power	BI,	Power	Query	&	Power	Pivot
·		 Project	finance
·		 Real	options	analysis
·		 Refinancing	/	restructuring
·		 Strategic	modelling
·		 Valuations
·		 Working	capital	management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:
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Sydney Address: SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address: SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address: SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address: SumProduct Pty Ltd, Level 9, 440 Collins Street, Melbourne, VIC 3000
Registered Address: SumProduct Pty Ltd, Level 6, 468 St Kilda Road, Melbourne, VIC 3004

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we thought we look at 
an even more combinations of those pesky FUNCTION keys…

Keystroke What it does

ALT + SHIFT + F1 Insert new sheet

ALT + SHIFT + F2 Save

ALT + SHIFT + F4 Close application

ALT + SHIFT + F10 Show On-Object User Interface (OOUI)

ALT + SHIFT + F11 Show Script Editor

CTRL + ALT + F1 New macro sheet

CTRL + ALT + F2 Open

CTRL + ALT + F3 New Name

CTRL + ALT + F4 Close application  

CTRL + ALT + F5 Refresh all

CTRL + ALT + F8 Disconnect display (Windows Key + P restores)

CTRL + ALT + F9 Full recalculation

CTRL + ALT + F12 Thai dictionary

CTRL + SHIFT + F1 Show / hide Ribbon and Quick Access Toolbar together

CTRL + SHIFT + F3 Create Names

CTRL + SHIFT + F4 Find previous (from most recent search)

CTRL + SHIFT + F6 Previous window / workbook

CTRL + SHIFT + F12 Print

CTRL + ALT + SHIFT + F2 Print

CTRL + ALT + SHIFT + F4 Close application

CTRL + ALT + SHIFT + F9 Full recalculation rebuild


